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PP When submitting your artwork please make sure to reference the following:
Submitting Artwork: ubmitling your artwork p u wing

» Order, Quote, Purchase or Confirmation number
» Contact information
» Special messages you would like us to know about your artwork/order

* Email Your Artwork To: custom@dfsbusiness.com

» When emailing your artwork, please attach your files rather than embedding or pasting your artwork into the email.
» Do not supply a link to download your file; we are not authorized to access most websites.
» Reference all order & contact information within the email.

If you are having any issues emailing your artwork, or for files too large to email, we also accept:

» Uploaded Artwork via Sharefile.com
Click on this Link to upload artwork: designservices.sharefile.com
Upload instructions maybe found here:  ShareFile.com instructions

» Mailed hard copies, discs and flashdrives
Hard copies must be clean, clear and legible.
Mail to: DFS Artwork Services
Attn: Design Services / CID or Order Number
642 Cowpath Road #283
Lansdale, PA 19446
sreference all order & contact information

m - All logos must be at least 1" x 1" at 300 DPI resolution to print well at press.
Scanned images should be scanned at ACTUAL print size and at least 300 DPI resolution.
Images pulled from a website are usually 72 DPI and are not an acceptable resolution for print.
Printing these images will result in blurry and pixilated artwork.
 For optimal printing quality, we prefer vector (or computer drawn) artwork over scans, copies and photographs.
* Remove any extra items in your files and keep illustrations clean.
» All text should be converted to outlines, curves or paths depending on what program you are working with.
» We do not accept faxes.
» Make sure there is a file extension at the end of your naming convention. Ex: logo.PDF

File Formats: We accept and support the following formats:

Preferred File Formats:
* PDF, EPS, Al, CDR, TIFF

Acceptable File Formats:
* PSD, PS, QXD, IND, JPG, PNG

» Microsoft office: Artwork submitted by Word or Publisher will take additional time to process and may
delay your order. To avoid any delays, please save your Microsoft file as a PDF file from the original
computer your artwork was created on to embed all fonts and images.

*We do not accept Excel or Powerpoint files.

| rtant Note: e Custom orders valued at $1,000 or greater, before applicable discounts may NOT be covered
Aferelneinl el by our 100% Unconditional Guarantee.

We can attempt to work with other file formats, but not all formats are compatible or considered print ready.
If your artwork is not considered print ready we may charge an additional fee to redraw if you cannot provide a better file.
We may need to alter your logo to fit our printing specifications.
An Electronic Art Representative will be in touch with you if your artwork does not meet our requirements.


https://designservices.sharefile.com/remoteupload/e4eef5c7-24f4-4087-bc99-1a54c3398e54
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SHETCIIIREJn] 1. Use the following link to access Design Services’ ShareFile upload page:
Instructions: https://designservices.sharefile.com/remoteupload/e4eef5c7-24f4-4087-bc99-1a54c3398e54

2. Enter all requested information on the upload form. Cantact Name/Customer:

* Be sure to use the Contact Name, Email Address
and Phone Number used while placing your
Order/Quote request.

Email Address:

Contact Phone Number:

* If no Order or Quote Number is available, please
supply any other Reference Number you have
that might help us associate your artwork with Quote/Order Number:
your order. (Ex: PO#, G#)

* Include any special instructions or requests e
concerning your artwork in the Notes field.

3. Browse to your saved artwork files or Drag them into the window indicated.

To Upload Multiple Files: e items  Clear all + Add more
* Multiple files can be uploaded simultaneously. X 205123456_1pdf 654 MB
* You may also Zip your files and upload the Zipped file. x 205123456_2.pdf 6.54 MB

Note: If your artwork contains many pre-linked files,
then zipping these in advance of uploading is the
suggested method, as this helps to preserve the links.

4. As files are added, they will appear on the Upload list. Once all files have been added, select Upload.

5. Files will upload one at a time, the status of each indicated on an upload status bar next to the file name.
Once all files show as uploaded, the upload window may be closed.

To Upload Additional Files:

Close the original upload session window and reselect the link above to begin a new upload session.
Reusing the same upload session can prevent the files from uploading properly.

If you have any problems while attempting to upload your artwork, please contact Electronic Art Department

888.229.6327


https://designservices.sharefile.com/remoteupload/e4eef5c7-24f4-4087-bc99-1a54c3398e54

888.229.6327
Electronic Art Department
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Resolution:

Resolution is the amount of detail available in an image, directly effecting picture quality.
It is measured by dots per inch (DPI) or pixels per inch (PPI).

Resolution Requirements

¢ All logos must be at least 1" x 1" at 300 DPI (dots or pixels per inch) resolution to print well at press
Images pulled from a website are usually 72 DPI and are not an acceptable resolution for print.
Printing these images will result in blurry and pixilated artwork.
* DO NOT try to change from a low resolution to a higher one by increasing the resolution in your imaging
program. This will cause the image to print blurry and pixilated. This may also cause a delay on your order.

Scanned Images

e Scanned images should be scanned at ACTUAL print size and at least 300 DPI resolution.
e A scanner must be preset to the proper resolution before the image is captured.

Many scanners default to 150 DPI resolution.
e Set scanner to Grayscale or Color, do not scan in Bitmap.

Acceptable Print-Ready Logo Non-Acceptable Logo

DFS) DFS)

You. Unlimited. You. Unlimited,

2" x 2" at 300 DPI resolution 1" x 1" at 72 DPI resolution

How to Check Resolution of your Logo in Photoshop

* Image > Image Size
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We can attempt to work with other file formats, but not all formats are compatible or considered print ready.
If your artwork is not considered print ready we may charge an additional fee to redraw if you cannot provide a better file.
We may need to alter your logo to fit our printing specifications.
An Electronic Art Representative will be in touch with you if your artwork does not meet our requirements.
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. When submitting your signatures please make sure to reference the following:
Signatures:

¢ Order, Quote, Purchase or Confirmation number
¢ Contact information

Follow instructions under Submitting Artwork for sending us your signature file.

Signature Requirements

* Sign your signature 3 times on a blank white piece of paper in black ink.

* Do not sign your signatures on lined paper or in marker.

Reference your order and contact information on your signature sheet to avoid delays.

If you can’t mail us a hard copy of your signatures, you may also scan them and email to us.

When scanning your signatures, please scan at ACTUAL print size and at least 300 DPI resolution.
A scanner must be preset to the proper resolution before the image is captured.
Many scanners default to 150 DPI resolution.
Set scanner to Grayscale or Color, do not scan in Bitmap

Acceptable Signature File i Shaith
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Non-Acceptable Signature Files: All examples may delay your order.

Scanned less than 300 DPI resolution Signed on lined paper Signed with marker
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An Electronic Art Representative will be in touch with you if your artwork does not meet our requirements.
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Helpful Tips for Saving Artwork Correctly

* How to: Make sure lllustrator document is clean with no extra hidden items

To make sure there are no extra hidden items in your file to keep it clean and to avoid delays,
press CTRL + Y in lllustrator. This allows you to view all layers of your document in Illustrator.

Example of file ready to be sent Example of same file in CTRL + Y mode
1 FIRDEN TE
You. Unlimited. You. Unlimited.

* How to: Make a Microsoft PDF file

Artwork submitted by Word or Publisher will take additional time to process and may delay your order.
To avoid any delays, please save your Microsoft file as a PDF file from the original computer your
artwork was created on to embed all fonts and images.

You need to have Adobe Acrobat to create the PDF.
1. Right click on the name of your file.

2. Choose convert to Adobe PDF.

3. Save file.

If you do not have Adobe Acrobat, go online and make a free pdf:  www.freepdfconvert.com

* How to: Create text/fonts into outlines or curves

lllustrator and Indesign Corel
e Select All: press CTRL + A e Select All: press CTRL + A
e Create Outlines: press SHIFT + CTRL + O e Convert to Curves: press CTRL + Q
or select the Type menu then scroll down or select the Arrange menu then scroll
to Create Outlines down to Convert to Curves
* How to: Purchase/Download Internet or Stock Photo images correctly.

* When downloading or purchasing images from the Internet, make sure they
are at least 300 DPI Resolution

* Example to the right is an image not purchased or downloaded correctly
from a Stock Photo website. These are not acceptable files for us to print.
Once the file is downloaded correctly, the logo will not appear on the image

e Use website instructions on all Stock Photo websites for correct download.

* Do not right click on image and save to your computer.

An Electronic Art Representative will be in touch with you if your artwork does not meet our requirements.


www.freepdfconvert.com
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Full Color:

Full-Color, Print-Ready Acceptable Format: * High-resolution PDF files only

Orders valued at $1,000 or greater, before applicable discounts may NOT be covered by our
100% Unconditional Guarantee. This means that DFS will not be responsible for:

* Spelling, punctuation or grammatical errors

* Inferior quality or low-resolution images

* Design errors introduced by the customer.

To keep costs down and ensure you get the quality product you can be proud of, please review all art files
carefully and correct any mistakes prior to placing your order or providing your artwork.

Y ITEMS TO WATCH FOR WHEN CREATING PRINT-READY PDF DOCUMENTS vy

SIZE & BLEEDS

CROP MARKS

OUTLINE ALL
FONTS

SINGLE PAGES

COLOR

RESOLUTION

DOCUMENT SIZE
375" X 2.25°

» All PDFs submitted should be saved at ACTUAL print '

size, plus a .125" or p9 bleed added on all 4 sides. This adds
* For example, a 3.5" x 2" business card should be set | PR
up as a 3.75" x 2.25" document. See EXAMPLE. } » Personal Ohe:on-Dre Atention
» When an image extends past the trim edge, this is a bleed. B et s
* In the document layout program (ex., Quark, Indesign) you {123 Main Street
must extend the bleed out past the document edge. i ?Q&?gg;jﬁéf;?
* Using guides is helpful. | 555-123-4567

L TRIM SIZE |
FEAX2T

» Do not add crop marks to any PDF submitted for print.

»All fonts should be “outlined ” or turned to “curves” on entire file prior to saving your PDF.

Single Pages Spreads
» Save your PDF as SINGLE PAGES in consecutive order. E%i—]
¢ Any layout over 2 pages should be saved as one PDF file.
* DO NOT design in Spreads (also known as Facing Pages). J
* Design in Single Pages only. ]

7

* Files should be created in CMYK color, not RGB. (CMYK is for printing, RGB is for screen and Web only.)
Black text should be 100K, not “Built” black.
e (C-0/M-0/Y-0/K-100)
Large black areas over .5" should use as “Built” black
e (C-50/M-40/Y-40/ K-100)

» For best quality printing, 300 DPI Resolution images are required.
* 72 DPI is not an acceptable resolution for images for printed products.
* Resolution is the amount of detail available in an image, directly effecting picture quality.
It is measured by dots per inch (DPI) or pixels per inch (PPI).

300 DPI
+ — Print Quality

An Electronic Art Representative will be in touch with you if your artwork does not meet our requirements.
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Contact Us:

If you have any questions or have any problems with your artwork file, please contact our Electronic
Art Department. Please make sure to include your Order, Quote, Purchase or Confirmation number
when contacting us.

Thank you for ordering DFS Business products!

Electronic Art Department

YW Phone: ) 888.229.6327

* Email: custom@dfsbusiness.com

* Mail: DFS Artwork Services Attn: Design
Services / CID of Order Number
642 Cowpath Road #283
Lansdale, PA 1946



